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Adding A Network Printer 

Connect to a 
printer 

This job aid will show you how to connect to a network printer. 

Step Action 

1.  On the Start menu, point to Settings. 

2.  Click on Printers And Faxes.  A window will open showing 
currently installed printers. 

3.  Double click the ADD Printer icon. The Add Printer Wizard 
will open. Click Next. 

4.  Select Network Print Server if it is not already selected. 

5.  Click Next.  The Connect to Printer window will open. 
  

6.   
If… Then. 

 

  You know the server 
location and name of the 
printer you want to 
connect too… 

A. Click the Connect To 
This Printer option 

B. Type in the name of the 
printer using the 
suggested format. 

C.  Click Next. 

 

  You want to browse for 
the printer you wish to 
connect too… 

A. Select Browse for a 
Printer.   

B. Click Next and scroll 
down the list of printers 
until you see the printer 
you want to add and 
click on it to select it,  

C. Click Next. 

 

       
7.   

If… Then. 
 

  You want this to be your 
default printer OR it is 
the only printer you will 
be using… 

Select Yes to set as default.  

 You do not want this to 
be your default printer 
OR you are connected to 
other printers… 

Select No to set as default.  
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8.  Click Next. 

9.  Click Finish. 
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Service Requests Using CG Help (Remedy Action Request System) 
CG Help is a trouble ticket (service request) system used to help ESU’s and ESD’s manage 
work requests and trouble calls. Users can electronically submit and track the progress of 
work requests via any Standard Workstation 
 

Ticket 
Submission 

This job aid will show you how to submit a service request (ticket) 
using CG Help (Remedy Action Request System). 

Step Action 

1.  Click on the CG Helpdesk Icon on your desktop  

 
OR click Start, Programs, USCG Apps, Action Request System, 
CG Help. 

  
2.   

If… Then 
 

  You get a dialog box 
titled “Not Logged On 
To All Servers – 
Remedy User… 

Click the OK button. The 
system will connect and the 
Login screen will open. 

 

     

3.  Enter the user name Webguest (it may already be there by 
default). 

4.  Enter the password Webguest. 
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5.  Click the OK button. Wait for the server to log you in. The 
Ticket Submit window will open. 
 

6.  Enter your e-mail address in the E-mail Address field and press 
Enter. 
 
Note: This is a searchable field. If you enter only the first few 
letters of your email address then press enter, the remaining 
profile fields will be populated for you, or a list will come up 
that you can choose from. Double-click your name to populate 
the fields automatically. 

  
7.   

If… Then 
 

  The wrong information 
populates the user 
profile fields… 

Click the Clear button and 
return to step 6. 
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8.  Enter a brief summary of the request or problem in the 
Summary field. (E.g. E-mail Not Working) 

9.  Enter a detailed description of the request or problem in the 
Description field. (E.g. I cannot find all the files and folders I 
was saving in my e-mail or my inbox.) 
 
Note: Be as descriptive as possible. Include any error 
codes/messages or unusual dialogue boxes. The more 
information you provide, the faster the technicians can address 
the request and take action. 

10.  Click the Submit button. The Request Created dialogue box will 
open (it may take a few seconds to appear). 

 

 
You do not need to write down any of this information. 
Confirmation e-mail will be sent to you containing the request 
ID. 

11.  Click the Close button. You will be returned to a blank Ticket 
Submit form. 

  
12.   

If… Then 
 

  You want to submit 
another ticket… 

Return to step 6.  

  You are finished 
submitting tickets… 

Click the Exit button.  

     

13.  Once the ticket has been assigned to a technician and the request 
completed, you will receive a notification of ticket-closed e-
mail. The technician will contact you if additional information is 
required to complete the request. 
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Checking 
Ticket Status 

This job aid will show you how to check the status of a service request 
(ticket) using CG Help (Remedy Action Request System). This portion 
of the job aid assumes you have logged into CG Help before and are 
familiar with the Ticket Submit screen. 

Step Action 

1.  Start CG Help as normal using the Webguest account. 

2.  Fill in the profile information starting with your e-mail address. 

3.  Click the Status button. 

 
Any tickets that are still open will be listed, showing to whom it 
was assigned and the current status. 

4.  Click the Close button to close the status window. 

5.  Click the Exit button on the Ticket Submit form to exit the 
system. 
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Creating Desktop Shortcuts 
There are dangers in saving files directly to your desktop for easy retrieval. At a 
minimum if your profile is ever damaged, you may loose all of the files. It is strongly 
suggested to get in the habit of saving files to your U:\ drive (My Docuemtns) and 
creating shortcuts to those files on the desktop. Shortcuts are small in file size and easy 
to replace. 
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Move files off 
the desktop 

This job aid will show you how to move whole files off the desktop to 
your U:\ drive (My Documents). You should perform this function prior 
to attempting to create a shortcut to the file(s). 

Step Action 

1.  Right click once on the file to be moved off the desktop. 

2.  Trace to and click on Cut 

3.  Navigate to your U:/ drive. The most common way to navigate 
to the U:/ drive is via the My Documents Icon located on the 
desktop. 

4.  Once at the U:/ drive (My Documents), from the Edit menu, 
chooses Paste. 

Creating 
shortcuts on 
the desktop 

This job aid will show you how to create a shortcut on the desktop, to 
commonly used files or folders on your U:\ drive (My Documents) or 
any other location. 

Step Action 

1. Navigate to your U:/ drive or other file location. The most 
common way to navigate to the U:/ drive is via the My 
Documents Icon on the Desktop.  

2. Right click on the file that you want to create a shortcut to, and 
trace to Send To… 

3. Select Desktop As Shortcut. 
  

 
If… Then. 

 

 The Desktop As 
Shortcut option is not 
available… 

Continue to the next step.  

 The Desktop As 
Shortcut option was 
available…. 

The task is completed. Stop 
Here. 

 

4. 

      

  

5. Ensure you can see both your desktop and the folder or file you 
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are working with. You may need to resize (restore down) the 
window to do this by clicking the restore down icon in the upper 
right corner of the window. 

 
 

6. Right click on the file or folder you want to move and HOLD 
THE MOUSE BUTTON DOWN. 

7. Drag the icon out to the desktop and then release the mouse 
button. 

8. Click Create Shortcut Here… 

 

 
 

WARNING: You must insure you have a shortcut and not a 
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copy of the file or folder. If you have a copy of the file, delete 
the icon from your desktop and try again.  

WRONG                    CORRECT 

                 
 

A shortcut has a small arrow in the lower left corner of the icon. 
A copy of a file does not. 

 
 

Delete a 
Desktop Icon 

This job aid will show you how to delete an icon from the Desktop. 

Step Action 

1. Right click once on the icon to be deleted off the desktop. 

2. Trace to and click on Delete. 
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Steps for a Successful Login 

 
Steps for a 
Successful Login 

This job aid will walk you through the steps necessary to check for a 
successful log-in to a SWIII. 

Step Action 

1 Click Start and trace to Programs 

2 Double click the My Documents Icon 

3  

If  Then 

Access is granted to the My 
Documents 

Log-in to SWIII is successful 
and you may begin work. 

Access is denied to the My 
Documents 

Log-in process is 
unsuccessful and you must 
turn off the power to the 
machine* 

 

* If you have an unsuccessful log-in reach down and turn off the 
power to the workstation.  Wait 30 seconds then turn on the 
power to the workstation.  Once you have turned on the 
workstation and have the “Ctrl+Alt+Delete” window wait 1 
minute before signing in.  
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Using Task Manager To End Frozen (Locked) Programs 

Introduction The Windows XP task manager can be used to quit an application that 
has stopped working (responding), without rebooting or logging off. 
Follow these steps to use Task Manager to quit a program. 

Step Action 

1.  Press CTRL + ALT + DELETE. 

2.  Click the Task Manager button.  The Task Manager will open. 

3.  Click the Applications tab.  A list of currently running 
applications will be displayed with the status. 

 
4.  Click on the application that is “Not Responding” to highlight 

it. 
5.  In the window that appears, click End Task. Wait a few 

moments. 

Note: You may need to drag the Task Manager window up into 
the middle of the screen to see the whole window and end task 
button. 

After a few seconds the program will quit. 

6.  Close Task Manager and continue working. 
 
 

If an application continues to lock up, contact your system 
administrator. 

 

Task Manager  Page 11 
Revised: 6/12/2003 



    Information Resource Center  Training Center Petaluma 

Accessing Coast Guard Publications and Directives 

Viewing 
Publications 

Use this job aid whenever you need to view a Coast Guard Publication 
on SWIII. 

Step Action 

1 From the Start menu, trace to Programs then trace USCG 
Program Apps and double click on Pubs & Directives. 

2 Enter your name and a password in the box that appears.  You 
can use any password you like. 

3 Click OK. 

When the CG Pubs & Directives program opens the following 
window will appear. Do not close this window for any reason! 

 
Closing this window causes the program to lock up.  If the 
program locks up, see the job aid Using Task Manager. 

4 From the Browse menu choose Table of Contents. 
5 Double click the type of publication or directive you are 

seeking.  
Example: Commandant Instruction Manuals 

6 Scroll through the list of publications and Double-click the 
publication you wish to view. 
Example: 5216.4B-Correspondence Manual 

7 Select the chapter you want to view and Double-click. (some 
publications may not have chapter numbers listed) 
Example: 3. 

8 The publication will be displayed.  Use the scroll bar to navigate 
through the document. (Remember: Do not close the view 
window!) 
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Using JetForm Filler 

Using a Form Use this job aid whenever you need to open a blank form for data entry on 
SWIII. 

Step Action 

1.  From the Start menu, trace to Programs and open JetForm Filler.
2.  Click the Use Form button. The "Open Form File" window will 

appear. 
3.  Double click the Forms folder. 
4.  Locate the folder containing the form you need. Folders are named 

based on the forms they contain.  Forms are listed by number, not 
by name. For example the form CG 3090- Miscellaneous Accrued 
Expenditure is in the CG 3000 folder. 

5.  Double click the folder. A list of forms (.mdf) files will appear in 
the left pane of the window.  My example is using the CG3000 
files. 

6.  Click the desired form.  A description of the form will be shown at 
the bottom of the window. 

7.  Click OK.  The form will open. 
  

Zooming into a 
Form 

Follow these step to zoom into a form. 

Step Action 

1.  From the Options menu select Zoom. The Zoom Options window 
will appear. 

2.  Select Actual Size. 

3.  Click OK.   
  

Entering Data 
into a Form 

When a form is opened the cursor should be in the first field.  

Step Action 

1.  Enter the data in the first field 

2.  Once the data has been entered use the Tab key to move to the 
next field. 

3.  Continue through the fields until all data has been entered. 
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Saving a Form When you are ready to save a form follow these steps. This will create a 
JetForm .dat data file. 
Step Action 

1.  Click the Save button.  The "Save Data As" window will appear. 

2.  Enter a file name for the form.   
Note: The name must be 8 characters or less plus .dat Example: 
MyOrders.dat 

3.  On the right side of the window select the folder where you want 
to save the form.  

4.  Click OK. 

  

Printing a Form When you are ready to print a form follow these steps. 
Step Action 

1.  Click the Print button.  The "Print" window will open. 
2.  Verify that the form will be printed on the desired printer.  The 

current printer is shown in the title bar of the window. 
3.  Select the desired print options. (Example would be 2 copies) 
4.  Click OK. 

  

Exiting 
JetForm 

When you are finished and want to exit JetForm click the Exit button.  

Opening a 
Form 

To open a form that you have already started or completed, follow these 
steps.  NOTE: This only applies to forms that have been saved as data 
files (.dat). 
If you wish to begin a new form, go to "Using a Form" on page one of this 
job aid. 

NOTE: You cannot open a JetForm .dat file by double clicking it.  You 
must open the form following these steps. 

Step Action 
1.  Open JetForm Filler. 
2.  Click the Open Data button. The "Open Data File" window will 

appear. 
3.  Locate and select the data file you want to open. 
4.  Click OK.  The form will open. 
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Using WinZip 8.1 to Compress or Decompress Files/Directories 

How To 
Compress  

This job aid will show you how to compress files/directories using the 
WinZip program. There are many options within the WinZip program. 
This job aid will step through using the default settings. For more 
information, use the HELP function within the WinZip program. 

Step Action 

1. Click on the START button. 

2. Trace to Programs, WinZip, then WinZip 8.1 

3. Click the Close button to close the "Tip of The Day". 
  

4.  
If… Then. 

 

  A file association dialog 
box appears 

Click Yes to associate .zip 
files with this application. 

 

  If a WinZip file 
association dialog does 
not appear… 

Go to the next step.  

     

5. Click the New tool.  

  
Note: Zipping means creating a new ZIP file, then compressing 
the files/folders you select in later steps into this “ZIP” file. 

6. In the New Archive window, use the Save In pull down to 
navigate to the location you wish to keep the zipped 
files/directory. 
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7. In the File Name box, type in what you want to name the zipped 
file. Keep in mind that you can compress multiple 
files/directories into one zipped file. Choose a descriptive name. 

 
8. Click the OK button. 

9. In the Add window, use the Look In: pull-down to navigate to 
the files/folders you wish to compress.  

  
10  

If… Then. 
 

  You want to compress the 
entire folder you are 
currently viewing … 

Click the Add With 
Wildcards button. This will 
keep the directory and sub-
directory structure in tact. 

 

  You want to selectively 
add files… 

A. Highlight the files 
you wish to 
compress, by clicking 
once on the file or 
folder name. 

B. Click the Add button. 

Hint: Hold down the Ctrl or 
Shift key to select multiple 
files 

 

     

11 To compress additional files with the same Zip file, click the 
ADD button, and repeat steps 8-10 

 
Note: you can add additional files at any time by opening the 
Zipped file and clicking the Add button. 

12
Close the window.  
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How Extract 
(Decompress)  

This job aid will show you how to extract files/directories using the 
WinZip program. There are many options within the WinZip program. 
This job aid will step through using the default settings. For more 
information, use the HELP function within the WinZip program. 

NOTE: It is possible to view/edit the contents of a zipped file 
without extracting (decompressing) it using the View button on 
WinZip's toolbar. 

Step Action 

1.  Double-click the Zipped file from which you wish to extract 
files. WinZip will launch. 

2.  Highlight each file/directory you wish to extract (decompress) 
by clicking once on it. 

Hint: Hold down the Ctrl or Shift key to select multiple 
files/directories. 

3.  Click the Extract button. 

 
4.  In the Extract window, use the Folders/drives area to navigate to 

where you want to extract the files. If necessary, use the New 
Folder button to create a folder. 

 
 

5.  Click the Extract button. The file(s)/Directory(s) will be 
extracted (decompressed) to the location you selected. 

Note: Extracting a file will not delete it from the Zipped file  
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Adding/Removing Shortcuts to Commonly Used Folders in Outlook 

Add Shortcuts Use the following steps to add a shortcut to your Outlook Bar.  
Shortcuts will save you time and reduce the need to search through a 
long list of folders.   

Step Action 

1 Open Outlook. 

2 On the Outlook Bar, right-click the gray background of the 
group where you want to add the shortcut.  

3 Click Add To Outlook Bar on the shortcut menu. The Add To 
Outlook dialogue box will appear. 

4 In the Folder Name box, locate the folder you wish to create a 
shortcut too. Click the name of the folder to highlight it. 

5 Click the OK button. The shortcut is now in your Outlook Bar.  
  

Remove 
Shortcuts 

The following steps will remove undesired shortcuts from the Outlook 
Bar. 

Step Action 

1 On the Outlook Bar, right-click the undesired shortcut. 

2 Click Remove From Outlook Bar on the shortcut menu.  The 
confirmation screen will appear. 

3 Click YES.  The shortcut is removed. 
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Move Your Personal Address Book Listing To The Top Of The List 

Word of Caution: 
If you are at all uneasy about making changes to your Outlook profile, it is suggested you 
perform these steps with a system administrator or someone else who has performed this 
function. Although you cannot lose any e-mail from performing these steps, you do stand a 
chance of “disconnecting” your user account from your e-mail. If this occurs, contact a 
System Administrator or the IRC for assistance. 
 

Move your 
Personal 
Address Book 
Listing 

This job aid will help you move your personal address book from the 
bottom of the Address book list to the top, just above the Global 
Address List. 

Step Action 

1. Close Outlook. 

2. Right-click the Outlook Icon on your desktop and select 
Properties.  

3. In the Information Services area of the window, click once on 
Microsoft Exchange Server to highlight it. 

 
4. Click the Properties button. 

5. Click the Advanced tab.  
  

6.  
If Then… 

 

  There are entries in the 
“open these additional 
mailboxes” field of the 
window… 

Write down the name of the 
mailboxes. You will have to 
reconnect to them later. Go to 
the next step. 

 

 There are no entries in 
the “open these 
additional mailboxes” 
field of the window… 

Move on to the next step.   
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7. Click the Cancel button. 

8. With Microsoft Exchange Server still highlighted, click the 
Remove button. 

9. Click Yes to confirm. 

10 Click the Add button. The Add Service to Profile dialogue will 
open. 

11 Click once on Microsoft Exchange Server to highlight it. 

 
12 Click the OK Button. The Microsoft Exchange Server dialogue 

will open. 

13 Enter “TRPETEX” (or your exchange server) in the Microsoft 
Exchange Server field. 

14 Enter your User Name in the Mailbox field. (The same name 
you use to sign onto the workstation.) 

15 Click the Check Name button. Your full name should appear 
and be underlined. 
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16  
If Then… 

  Your full name appears… Continue with the next 
step. 

You get an error that the 
name could not be resolved… 

 

Check the spelling of the 
Exchange server and your 
user name to insure they 
are correct. 

 

  

 

17 Click the OK button. 
  

18  
If Then… 

  In step 6 you wrote down the 
names of additional 
mailboxes to open… 

Proceed to the section of 
this job aid labeled 
“Opening Additional 
Mailboxes”. 

In Step 6 you did not write 
down the names of additional 
mailboxes to open… 

 

Click the OK button to 
close the MS Exchange 
Settings window.  You’re 
finished. 

 

  

 

Opening 
Additional 
Mailboxes 

This job aid will show you how open additional mailboxes from your 
MS Outlook profile. 

Step Action 

1.  Close Outlook. 

2.  Right-click the Outlook Icon on your desktop and select 
Properties. The MS Exchange Settings Properties window will 
open. 

3.  In the Information Services area of the window, click once on 
Microsoft Exchange Server to highlight it. 
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4.  Click the Properties button. 

5.  Click the Advanced tab. 

6.  Click the Add button. 

7.  Type in the User Name of the mailbox you want to open. 

 
8.  Click the OK button. 

  
9.   

If Then… 
 

  You get an error that the 
name cannot be resolved… 

Be certain you are typing 
the name correctly. It must 
be spelled exactly as the 
user would sign onto a 
workstation. 

 

There are no errors… The name should have 
appeared in the Mailboxes 
field. 

   

  

10.  Click OK to close the Exchange Server dialogue box. 

11.  Click OK again to close the MS Exchange Properties window. 
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Using Public Folder Favorites 

Introduction Adding folders to your Favorites Public Folder is a convenient way to 
organize information and quickly access shortcuts to items, documents, 
and other folders that you use frequently.  

Follow these steps to add a favorite to Public Folders Favorites 

Step Action 

1.  If the Folder List is not visible, click to the Folder List button 
to make it visible.. 

2.  Locate the public folder you want to add as a shortcut in 
Favorites.  

If you do not know how to locate public folders, please see the 
job aid How to Locate TRACEN Public Folders. 

3.  On the File menu, trace to Folder, and then click Add to Public 
Folder Favorites.  The Add to Favorites window will open. 

4.  Click the Add button.  The public folder will be added to your 
Public Folders Favorites. 

  

Accessing 
Favorites 

Follow these steps to access your Public Folders Favorites 

Step Action 

1.  Click the Other label on the Outlook Bar 

2.  Click the Public Folders icon. 

3.  In the Folder List, expand the list of subfolders by clicking the 
plus sign (+) beside Public Folders.  The Folder list will expand 
to show Favorites and All Public Folders. 

4.  Click Favorites.  Your favorites will be displayed 
5.  Click the folder you wish to view. 
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Compressing Your Outlook Archive File 
Compressing the Outlook Archive folders can considerably reduce the amount of hard 
disk space used by your U:/ drive (My documents). In some cases as much as 100MB or 
more. It takes only a few simple steps to compress the folders. 
 

See how much 
space you are 
using before 
compressing 

This job aid will show you how to check the amount of hard disk space 
your Outlook Archive file is using before you compress it. This is a 
good way to compare  "before and after". 

Step Action 

1. Double click on the Icon with your name under it on your 
desktop. 

2. Scroll down to the Icon with Users in the title and right click on 
it. 

3. Locate the folder with your name on it and right click once on 
it. 

4. Trace to and select Properties. About half way down the 
properties window will be the size information. 

 
 

 

Compress the 
archive file  

This job aid will show you how to compress the Outlook Archive file. 

Step Action 

1.  Make sure Outlook is closed (not running). 

2.  Right click on the Outlook Icon on your desktop. 

3.  Trace to properties, click on Services tab. 
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4.  Double click the Archive Folders file. This file may 
alternatively be named ~messages. 

5.  Select the Compact Now button.  

 
6.  It may take as much as 10 minutes to compact the file, 

depending on the original size. Try looking at the file size by 
using the steps outlined at the beginning of this Jobaid to see 
how much space you saved. 
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Setting Up Task Manager in Outlook 

Introduction This Job Aid will show you how to organize Microsoft Outlook to 
properly use Tasks.  It is imperative that every individual who will be 
sharing tasks complete this Task Manager Set Up in order for Task 
Manager to work properly. 

Step Action 

1. Outlook by double clicking on the Microsoft Outlook icon on 
your desktop. 

2. On the menu bar click Tools and trace to Rules Wizard. 

3. It will ask you to choose which set of rules to use Client or 
Server. Choose Server.  

4. Click New. The Rules Wizard screen is displayed.  

 
5. Highlight Check messages when they arrive from the top 

window by clicking it once.  

6. Click Next. 

7. Scroll down and select Uses the form name form by clicking in 
the check in the box next to the option.  

8. After you have checked the appropriate box in the top window, 
click on form name in the bottom window.  
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9. Select Application Forms from the form pull down menu. 

10 From the Application Form menu Select and click Add for the 
following (7) items: Accept Meeting Response, Decline 
Meeting Response, Task Accept, Task Decline, Task 
Request, Task Update, Tentative Meeting Response 

 
11 Click Close. 

12 Click Next. 

13 Select move to a specified folder by clicking in the check in the 
box next to the option. 

14 Click on specified in the bottom window. 
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15 Select Inbox under Outlook Today.  Ensure that the highlighted 

Inbox is in your Mailbox (last name, first name) and not the one 
in your ~Messages/Archive folders.  Then click OK.  

 
16 Select stop processing more rules by clicking in the check in 

the box next to the option. 

17 Click Next. The Exception Dialogue will open. 

18 No Exceptions are necessary. Click Next.  

19 In the box named “Please Specify A Name For This Rule”, 
overtype the name with Tasks and Meetings. 

20 Click Finish. 

21 Check to make sure that “Tasks and Meetings” is at the top of 
the Rules Wizard window list. 
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  If… Then…  

  “Tasks and Meetings” is 
not at the top of the 
Rules Wizard list… 

Highlight “Tasks and 
Meetings” by clicking on it 
once. Use the Move Up/Move 
Down buttons located under 
the window, move the rule to 
the top of the list. 

 

  “Tasks and Meetings” is 
at the top of the Rules 
Wizard list… 

Click OK.  

     

 

 
 

The task manager is now set up correctly. 
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Setting Up CG Macros II 

USCG Macros 
II Templates 

USCG Macros II templates were designed to generate standard Coast 
Guard letters and memorandums, making the entire process of preparing 
Coast Guard correspondence much easier.  This job aid will show you 
how to set up USCG Macros II in Microsoft® Word.   

Step Action 

1. On the Start menu, point to Programs then click on Microsoft 
Word. 

2. Click File and then click New… 

3. Click on the tab that says USCGMacrosII and double click 
CGSetUp.dot 

4. You will be taken to the Setup window.  Fill out this form with 
the correct information. 

 

5. Click Finish. 

6. Again use the File menu and click New… 

7. Click the tab that says USCGMacrosII.  

8. Double click the type of correspondence you wish to create. 
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Determining Your File Server 

Finding Your 
File Server 

Many times in order to accomplish basic network tasks, you must first 
know your file server.  This job aid will show you how to determine the 
location of your file server. 

Step Action 

1. On the Desktop open My Computer. 

2. Click once on your U: drive.  It should look something like this: 

 
3. In the left-hand information pane you should see a Details bar: 

4. 
  

 
If Then… 

 

 The details bar looks 
like this: 

Click once on the  arrows  

 The details bar looks 
something like this: 

Continue to the next step  

     
5. In the Address Bar near the top of the window type \\ and then 

the rest of the information you see in single quotes in the Details 
information pane.  After you finish, it should look something 
like this:  

 
6. 

Press the Enter key or click the  button 

7. You are now in the folder of your file server.  The address in the 
Address bar can be used to access your file server from a variety 
of programs. 
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Accessing Your Public Folder 

Your Public 
Folder 

The public folder is the opposite of the U:\ drive or My Documents. 
When you put something in your public folder you are inviting other 
users to look at the information you put there. For example: you may 
have a digital picture you want to share; rather than e-mailing a 3MB 
picture to people who may or may not want it, just put it in your public 
folder and tell people it is there. They can choose to take copy or not. Or 
perhaps you’re working on a project with multiple people, or you have 
to publish a schedule. In order to share information (files, etc.) with 
other users, you need to place that information in your Public folder.  
This job aid will show you how to determine the location of your public 
folder, and place a shortcut to it on your desktop.  Also see the job aid 
entitled Determining Your File Server. 

Step Action 

1. On the Desktop open My Computer. 

2. Click once on your U: drive.  It should look something like this: 

 
3. In the left-hand information pane you should see a Details bar: 

4. 
  

 
If Then… 

 

 The details bar looks 
like this: 

Click once on the  arrows  

 The details bar looks 
something like this: 

Continue to the next step  

     
5. In the Address Bar near the top of the window type \\ and then 

the rest of the information you see in single quotes in the Details 
information pane.  After you finish, it should look something 
like this:  
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Note: This is referred to as your “user share” or “file server”. 
For others to access your public folder you will have to tell them 
your file server information. 

6. 
Press the Enter key or click the  button 

7. You are now in the folder of your file server.  The address in the 
Address bar can be used to access your file server from a variety 
of programs. 

8. Right click on the Public folder and select Create Shortcut. 

9. You should see a dialog box like this: 

 
10 Click Yes. 

11 You can now access your Public folder – it’s called Shortcut to 
Public – from the Desktop.  Simply drag the files you want to 
share into this folder. 
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Creating an Auto Signature in Outlook 

Auto Signature The Signature feature in Microsoft® Outlook is used to append your 
contact information to the end of your e-mails. 

Step Action 

1. On the Start menu point to Programs, then click on Microsoft 
Outlook. 

2. Use the Tools menu and click on Options… 

3. Click the Mail Format tab and click Signature Picker… 

4. Click New… 

5. Enter a name for your Signature in the field: 

 
6. 

  
 

If Then… 
 

 You have no pre-
existing file to create 
your signature 

Click the button that says 
Start with a blank 
signature: 

 

 You have a pre-existing 
file you want to use for 
your signature 

Click the button that says Use 
this file as a template: and 
browse to the file 

 

     
7. Enter all the necessary information and click Finish 

8. Click OK 

9. 
  

 
If Then… 

 

 You want the signature 
to appear on every one 
of your e-mail 
messages. 

Uncheck the box that says 
Don’t use when replying or 
forwarding. 

 

 You don’t want the 
signature to appear 
when you are 
forwarding or replying 
to e-mail messages. 

Make sure the box that says 
Don’t use when replying or 
forwarding is checked. 

 

     
10 Click OK.  Your signature will - by default – be placed at the 

end of the e-mail messages you send. 
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Setting Up Auto Archive in Outlook 

Auto Archive Auto Archive is a feature within Microsoft® Outlook that automatically 
archives or deletes mail after a specified period of time.  This job aid 
will show you how to set up the Auto Archive feature. 

Step Action 

1. On the Start menu point to Programs, then click on Microsoft 
Outlook. 

2. On the Tools menu and click on Options… 

3. Click the Other tab and click Auto Archive. 

4. Select the AutoArchive every check box. 

5. Specify the number of days between Archives by entering a 
number in the days box. 

Suggestion: No less than once a week.  

6. Check the Prompt before AutoArchive box to be notified 
before each Auto Archive. This will produce a notification on 
the screen when the auto archive is going to run.  

7. Click OK. 

8. Right click on a folder for which you want to set the 
AutoArchive properties (e.g. Sent Items), and then click 
Properties. 

Note: It is most important to set the AutoArchive properties 
for the Sent Items and Deleted folders in both the default 
mail folder and the ~Messages or Archive folder.  

9. Click on the AutoArchive tab. 

10 Click on the Clean out items older than box and enter a 
number and select a unit for time. 

 
11  

If… Then…  

You want to archive the 
files 

Choose Move old items to: 
and browse to a location for 
the files (the default location 
is ‘U:\Mail\Messages.pst’). 

 

You want to delete the 
files 

Choose Permanently delete 
old items. 
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12 Click OK. 

 

Forcing An 
Archive 

It is possible to force Auto Archive to run at any time, regardless of the 
time interval you chose between archives. This job aid will show you 
how to force an Archive. 

Step Action 

1.  On the Start menu point to Programs, then click on Microsoft 
Outlook. 

2.  On the File menu and click on Archive… 

 
3.  Choose the settings you desire and click OK.  
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Setting Security Permissions in Windows XP 

Setting 
Permissions 
 

Setting permissions to folders and files within Windows XP will allow 
the owner (creator) to control whom, and what type of access is granted.  
Security in Windows XP is based on implicit and explicit permissions, 
and can prove be a complex issue. Describing in detail how Windows 
XP Security works is beyond the scope of this Job Aid.   
The chart on the last page of this Job Aid describes the different types 
of access permissions. 

Step Action 

1.  Right Click on the File Name or Folder that you wish to set 
permissions to. 

2.  Select Properties from the menu list. 

3.  Select the Security tab. 

 4.  

 If… Then…  

  You wish to change 
existing permissions… 

Move to the section labeled 
Change Permissions.  

 

  You wish to add 
permissions… 

Move to the section labeled 
Adding Users / Permissions. 

 

 You wish to remove 
permissions… 

Move to the section labeled 
Removing Users / 
Permissions. 

 

 You wish to find out 
more about advanced 
permissions… 

Move to the section labeled 
Advanced Permissions. 

 

 

 

  

Change 
Permissions  

This section will guide you through the steps required to change 
(replace) existing permissions for a directory (folder) or file. 

Step Action 

1.  In the Group or user names: field of the Security dialogue box, 
click on the Name you wish to change permissions to.  
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2.  In the field below, entitled Permissions for <group or user 

name>, select the desired options. Check ALL that apply. Use 
the chart on the last page if this Job Aid as a guide to the 
various options. 

 
3.  Select OK. 

  

Add Users  / 
Permissions  

This section will guide you through the steps required to add users and 
permissions for a directory (folder) or file. 

Step Action 

1.  Select the Add… button. The Add Users and Groups dialogue 
box will open. 
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2.  In the field entitled Enter the objects names to select, type in 
the Account Name of the person you wish to add. 

 
Note: The account is based on the users SWIII log-in name.  

For example: The user to add is John Doe. John's account name 
(how he logs into the system) is Jdoe. Hence, you would type 
Jdoe into the field. 

The Account Name must be an EXACT match, or the search 
function will not locate the account. 

 3.  

 If… Then…  

 You know the Domain 
the user is located in… 

You can narrow the search by 
clicking on the Locations…  
button and then the name of 
that domain to highlight it. 

 You do not know the 
Domain the user is 
located in… 

Simply move on to the next 
step. 

  

 
4.  Select the Check Names button. The User Name will appear in 

the search field. 

 5.  

 If… Then…  

  The correct name 
appeared in the field… 

Move on to the next step.  

 The incorrect name 
appeared on the field… 

Select the Cancel button and 
return to step 2. 

  

 

 6.  

 If… Then…  
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 You wish to add more 
names… 

Click inside the Enter the 
objects names to select field 
and delete the name. Repeat 
steps 2 through 6.  

 You have all the names 
you wish to add to the 
list of permissions… 

Move on to the next step. 

  

 

7.  Highlight all the names in the Search Results field by holding 
down the Shift key, and selecting each name in the list. Any 
name that is not highlighted WILL NOT be added. 

8.  Select the OK button. The Select Users or Groups dialogue box 
will close, and the selected names will show in the Add Names 
field of the Add Users and Groups dialogue box. 

9.  Select the desired type of access from the list of choices. Refer 
to the change permissions section. 

10.  Select the OK button. 
 

Remove Users 
/ Permissions 

This section will guide you through the steps required to remove users 
and permissions for a directory (folder) or file. 

Step Action 

1.  Highlight the Users Name from the list in the Name field. (One 
click of the left mouse button). 

2.  Select the Remove button. 

 3.  

 If… Then…  

  You wish to remove 
more Users… 

Repeat Steps 1 and 2.  

 You are finished 
removing Users… 

Move on to the next step.   

 

4.  In the Properties dialogue box, select OK. 
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Advanced 
Permissions 

This section will guide you through the advanced properties of 
permissions. 

Step Action 

1.  Under the Security tab click Advanced. 

 2.  

 If… Then…  

  You wish to 
add/edit/remove 
Users… 

Use the appropriate buttons 
under the Permissions tab 

 

 You wish to view the 
owner or change the 
owner of the 
file/folder… 

Click on the Owner tab.  
Depending on your 
Permissions you may be able 
to view or change the owner. 

 

 You wish to view the 
permissions that are 
given to a certain user… 

Click on the Effective 
Permissions tab.  Click the 
Select… button to select the 
user for which you wish to 
see permissions. 

 

 

 

3.  Click OK and click OK again. 

Note: See the end of this job aid for more information 
concerning Inheritance and how it affects permissions. 
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Special Access File and Folder Permissions 

You can set the following individual directory permissions when creating special access 
permission for directories: 

Special Permissions  Full 
Control Modify Read & 

Execute 
List Folder Contents (for 

folders only) Read Write

Traverse Folder/Execute 
File x x x x   

List Folder/Read Data x x x x x  

Read Attributes x x x x x  

Read Extended Attributes x x x x x  

Create Files/Write Data x x    x 

Create Folders/Append 
Data x x    x 

Write Attributes x x    x 

Write Extended 
Attributes x x    x 

Delete Subfolders and 
Files x      

Delete x x     
Read Permissions x x x x x x 

Change Permissions x      

Take Ownership x      
Synchronize x x x x x x 

*For more information use the Windows Help and look under ‘Access Control’ 

How inheritance affects file and folder permissions 

After you set permissions on a parent folder, new files and subfolders that are created in the 
folder inherit these permissions. If you do not want them to inherit permissions, select This 
folder only in Apply onto when you set up special permissions for the parent folder. In cases 
where you want to prevent only certain files or subfolders from inheriting permissions, right-
click the file or subfolder, click Properties, click the Security tab, click Advanced, and then 
clear the Inherit from parent the permission entries that apply to child objects. Include 
these with entries explicitly defined here. check box. 

If the check boxes appear shaded, the file or folder has inherited permissions from the parent 
folder. There are three ways to make changes to inherited permissions:  
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• Make the changes to the parent folder, and then the file or folder will inherit these 
permissions.  

• Select the opposite permission (Allow or Deny) to override the inherited permission.  

• Clear the Inherit from parent the permission entries that apply to child objects. 
Include these with entries explicitly defined here. check box. You can then make 
changes to the permissions or remove the user or group from the permissions list. 
However, the file or folder will no longer inherit permissions from the parent folder.  

In most cases, Deny overrides Allow unless a folder is inheriting conflicting settings from 
different parents. In that case, the setting inherited from the parent closest to the object in the 
subtree will have precedence.  

Only inheritable permissions are inherited by child objects. When setting permissions on the 
parent object, you can decide whether folders or subfolders can inherit them with Apply onto. 
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